Oracle® ldentity Manager

Integration Guide for Crystal Reports

Release 9.1.0.1

E14060-01
February 2009

This document explains how to use Crystal Reports Developer XI and Crystal Reports
Server XI to create Crystal Report versions of Oracle Identity Manager reports. This
document contains the following sections:
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Configuring Crystal Reports Lookups for Oracle Identity Manager Input
Parameters

Files Required to Run Each Report

Configuring Reports for Crystal Reports Developer and Crystal Reports Server
Creating Users, Configuring Access, and Distributing Reports

General Limitations

Documentation Accessibility

Configuring Crystal Reports Lookups for Oracle Identity

Manager Input Parameters

"Lookup" is a term for a drop-down list that displays the available values for any
given input parameter. You must configure Crystal Reports lookups for Oracle Identity
Manager input parameters before configuring and running reports.

Perform the following steps to configure Crystal Reports lookups for Oracle Identity
Manager input parameters by using the Business View Manager:

1.

ORACLE

Start the Business View Manager. From the Microsoft Windows Start menu, select
Programs, then select Business Objects, then select Crystal Reports Server, and
then select Business View Manager. The Business View Manager is displayed.
Log in as the Administrator with Enterprise Authentication.

Click the Tools menu on the Business View Manager and select Import. The
Import dialog box is displayed.

Click the Choose XML button next to the XML Filename field on the Import
dialog box.

Browse to the location where the LookUps.xml import file is located, select it, and
click Open.

By default, the LookUps . xm1 import file is in the
\installServer\xellerate\db\Oracle\CrystalReports\ directory for
Oracle deployments and in the
\installServer\xellerate\db\SQLServer\CrystalReports\ directory
for Microsoft SQL Server deployments. Click OK on the Import dialog box to
import the file.




10.

Click the View menu on the Business View Manager and select Repository
Explorer. The Repository Explorer window is displayed in the Business View
Manager.

Select the List of Values from the Repository Explorer that you want to change the
connection for and click Show referenced objects. The Referenced Objects dialog
box is displayed.

Expand the List of Values option in the Referenced Objects dialog box so you can
see the connection level entry. Note the name of the connection and click Close on
the Referenced Objects dialog box.

Double-click the name of the connection entry in the Repository Explorer. The
settings for the connection appear in the Business View Manager main window.

Click the View menu on the Business View Manager and select Object Explorer
and Property Browser. The Object Explorer window and Property Browser is
displayed in the Business View Manager.

Click the Connection field in the Property Browser to set the value for the
connection. You can click any of the fields listed in the Property Browser to set
their value.

Note: You can verify the connection to the database by clicking the
Test Connectivity icon on the toolbar.

2 Files Required to Run Each Report

Table 1 lists the required files to run each report for both Oracle and Microsoft SQL
Server data sources.

Note: While the files to run each report for both Oracle and SQL
Server data sources have the same file names, the content of the files
are different for each data source.

For Oracle data sources, the files listed in Table 1 are located on the Oracle Identity
Manager installation CD in the following directories:

\installServer\xellerate\db\Oracle\CrystalReports\SP_Wrappers\

\installServer\xellerate\db\Oracle\CrystalReports\RPT\

For Microsoft SQL Server data sources, the files listed in Table 1 are located on the
Oracle Identity Manager installation CD in the following directories:

\installServer\xellerate\db\SQLServer\CrystalReports\SP_Wrapper
s\

\installServer\xellerate\db\SQLServer\CrystalReports\RPT\

Each report has an input parameter named Xellerate User Login. For all reports, the
default value of the Xellerate User Login parameter is xelsysadm. The Xellerate User
Login parameter corresponds to the xellerate user and is based on the report that will
run. The report follows the same security model as Oracle Identity Manager taking the
xellerate user as the logged in user.

When reports run, the Xellerate User Login parameter is suppressed and users cannot
edit the value for this parameter. The administrator or user that publishes the report




must set the value for the Xellerate User Login parameter according to the level of

security needed.

Note:

The files listed in Table 1 remain on the Oracle Identity

Manager installation CD and are not installed on a system when
installing Oracle Identity Manager.

Table 1 Files Required to Run Each Report
Report Wrapper Stored Procedure (.sql) RPT (.rpt)
User Resource XL_SP_UserResourceAccess_CR UserResourceAccess
Access
Resource XL_SP_ResPassExp_CR ResPassExp
Password
Expiration
OIM Password XL_SP_OIMPassExp_CR OIMPassExp
Expiration
Group XL_SP_GroupMembershipProfile_CR  GroupMembershipProfile
Membershlp Note: For Oracle, the wrapper stored
Profile :

procedure is named:

XL_SP_GrpMembershipProfile_CR.
Policy List XL_SP_PolicyList_CR PolicyList
Policy details XL_SP_PolicyDetail_CR PolicyDetail
Entitlement XL_SP_EntitlementSummary_CR EntitlementSummary
Summary
Attestation request XL_SP_AttestReqByProc_CR AttestReqByProc
by Process
Attestation XL_SP_AttReqDetail_CR AttReqDetail
Request Details
Attestation Process XL_SP_AttestProcList_CR AttestProcList
List
Attestation XL_SP_AttestReqByRev_CR AttestReqByRev
Request by
Reviewer
Resource Access XL_SP_ResourceAccessList_CR ResourceAccessList
List
User Access XL_SP_UserAccessHistory_CR UserAccessHistory
History
Resource Access ~ XL_SP_ResAccessLstHistory_CR ResourcAccessListHistory
List History Note: For Oracle, the wrapper stored

procedure is named

XL_SP_ResAccessLstHistory_CR
User Profile XL_SP_UserProfileHistory_CR UserProfileHistory
History
User Membership  XL_SP_UserMembershipHistory_CR  UserMembershipHistory
History




Table 1 (Cont.) Files Required to Run Each Report

Report Wrapper Stored Procedure (.sql) RPT (.rpt)
Group XL_SP_GroupMembershipHistory_CR GroupMembershipHistory
I\H/I? mbership Note: For Oracle, the wrapper stored
istory : .
procedure is named:
XL_SP_GrpMembershipHistory_CR
Group XL_SP_GroupMembership_CR GroupMembership
Membership
Approval Status XL_SP_ApprovalStatusByApprover_C ApprovalStatusBy Approv
By Approver R er
Note: For Oracle, the wrapper stored
procedure is named:
XL_SP_ApprovStatsByApprover_CR
Organization XL_SP_OrganizationStructure_CR OrganizationStructure
Structure
Financially XL_SP_FinanciallySigResources_CR FinanciallySigResources
%gmflcant Note: For Oracle, the wrapper stored
esources

procedure is named:
XL_SP_FinanciallySigResourc_CR

Resource Activity
Metrics

XL_SP_ResourceActivity_CR

ResourceActivity

Delegated XL_SP_Delegated AdministratorsByOr Delegated AdministratorsB
Administrators By g_CR yOrg
Organization Note: For Oracle, the wrapper stored

procedure is named:

XL_SP_Delegated AdminByOrg_CR
Delegated XL_SP_DelegAdminPermsByRes_CR  DelegAdminPermsByRes
Administrators

and Permissions
by Resource

Note: For Oracle, the RPT is named:

Delegated AdminPermsByRes.rpt
because the filename in the oracle
folder is

Delegated AdminPermsByRes.rpt

Note: For Oracle, the RPT
is named

Delegated AdminPermsBy
Res.

Requests Details

XL_SP_RequestDetailByStatus_CR

RequestsDetailsByStatus

by Status

Requests Initiated ~ XL_SP_RequestsInitiated_CR RequestsInitiated
Delegated XL_SP_DelegAdminPermsByOrg CR  Delegated AdminPermsBy
Administrators Org

and Permissions

by Organization

Users Created

XL_SP_UsersCreated_CR

UsersCreated

Task Assignment
History

XL_SP_TaskAssignmentHistory_CR

TaskAssignmentHistory

Account Activity ~ XL_SP_AccountActivityInRes_CR AccountActivityInRes
In Resource

Users Deleted XL_SP_UsersDeleted_CR UsersDeleted
Delegated XL_SP_Delegated AdminByRes_CR Delegated AdminByRes

Administrators by
Resource




Table 1 (Cont.) Files Required to Run Each Report

Report Wrapper Stored Procedure (.sql) RPT (.rpt)

Users Unlocked XL_SP_UsersUnlocked_CR UsersUnlocked
Users Disabled XL_SP_UsersDisabled_CR UsersDisabled
Password Reset XL_SP_PassResetSuccessFail_CR PassResetSuccessFail

Success Failure

Rogue Accounts XL_SP_RogueAccountsByResource_C  RogueAccountsByResourc
by Resource R e

XL_SP_FineGrainEntExcpByRes_CR

Fine Grained FineGrainEntExcpByRes
Entitlement
Exceptions by

Resource

3 Configuring Reports for Crystal Reports Developer and Crystal
Reports Server

This section explains how to configure Crystal Report versions of Oracle Identity
Manager reports for both Crystal Reports Developer and Crystal Reports Server. This
section contains the following topics:

s Configuring the Database for Crystal Report Versions of Oracle Identity Manager
Reports

s Configuring Reports to Run Against Crystal Reports Developer
s Configuring Reports to Run Against Crystal Reports Server

Note: The information in Configuring the Database for Crystal
Report Versions of Oracle Identity Manager Reports is common to
both Crystal Reports Developer and Crystal Reports Server.

3.1 Configuring the Database for Crystal Report Versions of Oracle Identity
Manager Reports

Perform the steps in one of the following sections appropriate for your type of
database to compile the wrapper stored procedure, which is the data source for the
report.

Note: Each wrapper procedure calls the parent procedure. The sixth
parameter in this call, named intpagesize_in in the parent
procedure, indicates the number of records for the report to retrieve.
By default, the value of intpagesize_inis set to 5000 in each
wrapper procedure.

If needed, change the value of intpagesize_in and save the file
before compiling the wrapper stored procedure.




3.1.1 Configuring Oracle Databases for Crystal Report Versions of Oracle Identity
Manager Reports

To configure Oracle databases for Crystal Report versions of Oracle Identity Manager
reports, execute the \Oracle\Wrappers\XL_SP_Report Name CR.sqgl script on
the database server by using the database login for Oracle Identity Manager.

3.1.2 Configuring Microsoft SQL Server Databases for Crystal Report Versions of
Oracle Identity Manager Reports

Perform the following steps to configure Microsoft SQL Server databases for Crystal
Report versions of Oracle Identity Manager reports:

1. Edit the \SQLServer\XL_SP_Report Name_CR.sqgl script and replace every
occurrence of the @sysuser string with the name of the SQL Server login for Oracle
Identity Manager.

2. Execute the updated \SQLServer\XL_SP_Report Name_ CR.sqgl script on the
database server by using the database login for Oracle Identity Manager.

3.2 Configuring Reports to Run Against Crystal Reports Developer

This section explains how to configure reports to run against Crystal Reports
Developer by using both Oracle and Microsoft SQL Server data sources. By default,
reports attempt to connect to the data source that was configured when the report was
initially designed.

To change the location of the data source that the report connects to, perform the steps
in the following sections specific to either Oracle or Microsoft SQL Server data sources.
This section contains the following topics:

s Configuring Reports to Run Against Crystal Reports Developer By Using Oracle
Data Sources

= Configuring Reports to Run Against Crystal Reports Developer By Using
Microsoft SQL Server Data Sources

3.2.1 Configuring Reports to Run Against Crystal Reports Developer By Using Oracle
Data Sources

Perform the following steps to configure reports to run against Crystal Reports
Developer by using Oracle data sources:

1. Open Crystal Reports Developer and log in as the Administrator with Enterprise
Authentication.

2. Open the \Oracle\RPT\Report Name. rpt file for the report you want to run.

3. Click the Database menu and select Set Datasource Location. The Set Datasource
Location dialog box is displayed.

4. Expand the Create New Connection option in the Replace With field of the Set
Datasource Location dialog box.

5. Select Oracle Server. The Oracle Server Connection dialog box is displayed.

6. Enter the name of the connection string defined in the TNSNAMES.ora
configuration file in the Service field.

7. Enter the database User ID in the User ID field.
8. Enter the password in the Password field and click the Finish button.




10.
11.

12.

Expand the entry for the user name/schema that compiled the wrapper stored
procedure from the list of options for the Oracle Server entry in the Replace With
field.

Select the wrapper stored procedure for the report.

Select the original datasource in the Current Data Source field of the Set
Datasource Location dialog box and click the Update button. The Enter Values
dialog box is displayed.

Enter the appropriate values for each parameter in the Enter Values dialog box
and run the report.

Note: Click the refresh button to run the report with new parameter
values.

3.2.2 Configuring Reports to Run Against Crystal Reports Developer By Using
Microsoft SQL Server Data Sources

Perform the following steps to configure reports to run against Crystal Reports
Developer by using Microsoft SQL Server data sources:

1.

© ®» N O

12.

13.
14.

15.

Open Crystal Reports Developer and open the \ SQLServer\RPT\Report
Name . rpt file for the report you want to run.

Click the Database menu and select Set Datasource Location. The Set Datasource
Location dialog box is displayed.

Expand the Create New Connection option in the Replace With field of the Set
Datasource Location dialog box.

Select OLE DB (ADO). The OLE DB (ADO) Provider dialog box is displayed.

Scroll through the list in the Provider box and select Microsoft OLE DB Provider
for SQL Server. Click the Next button. The OLE DB (ADO) Connection
Information dialog box is displayed.

Enter the SQL Server host name in the Server field.
Enter the database user ID in the User ID field.
Enter the password in the Password field.

Enter the name of the database in the Database field and click the Next button.
The OLE DB (ADO) Advanced Information dialog box is displayed.

. Click the Finish button on the OLE DB (ADO) Connection Information dialog box.
11.

Expand the entry for the database name in the list of entries for OLE DB (ADO) in
the Replace With field and select the user name that holds the wrapper stored
procedure for the report.

Expand the Stored Procedures entry for the user name that holds the wrapper
stored procedure for the report.

Select the wrapper stored procedure for the report.

Select the original datasource in the Current Data Source field of the Set
Datasource Location dialog box and click the Update button. The Enter Values
dialog box is displayed.

Enter the appropriate values for each parameter in the Enter Values dialog box
and run the report.




Note: Click the refresh button to run the report with new parameter
values.

3.3 Configuring Reports to Run Against Crystal Reports Server

This section explains how to configure reports to run against Crystal Reports Server.
The process for configuring reports to run against Crystal Reports Server includes the
following steps documented in this section:

1. Publishing Reports By Using the Publishing Wizard
2. Configuring Published Reports

3.3.1 Publishing Reports By Using the Publishing Wizard

The first step in configuring reports to run against Crystal Reports Server is to publish
the reports to the Crystal Reports Server. Perform the following steps by using the
Publishing Wizard to publish reports to the Crystal Reports Server:

1. Start the Publishing Wizard. From the Microsoft Windows Start menu, select
Programs, then select Business Objects, then select Crystal Reports Server, and
then select Publishing Wizard. The Welcome to the Publishing Wizard dialog box
is displayed.

2. Click Next on the Welcome to the Publishing Wizard dialog box. The Please Log
On dialog box is displayed.

3. Enter the following information in the fields on the Please Log On dialog box:

= Enter the host name of the system where Crystal Reports Server is running in
the System field.

= Enter your Crystal Reports Server user name in the User Name field.

= Enter your password in the Password field.

= Ensure the Authentication field is set to Enterprise and click Next.
The Select Files dialog box is displayed.

4. Click Add Files on the Select Files dialog box. Browse to the location of the RPT
file you want to publish, select the file, and click Open.

5. Click Next on the Select Files dialog box after the RPT file you selected is
displayed in the list of files to be published. The Specify Location dialog box is
displayed.

6. Browse to the location where you want the report to appear and click the Next
button until the Change Default Values dialog box is displayed.

7. Select the Publish without modifying properties option on the Change Default
Values dialog box and click Next. A Publishing Wizard dialog box is displayed
and lists the objects/reports you selected to publish.

8. (Click Next to publish the report. After publishing the report, click Finish.

3.3.2 Configuring Published Reports
After publishing reports to the Crystal Reports Server, you must configure the
published reports so that can users to access them.




Note: Be aware that you cannot configure and publish a report
designed for Oracle against an SQL Server data source, and you
cannot configure and publish a report designed for SQL Server against
an Oracle data source.

Step 10 in the following procedure will differ for Oracle and SQL
Server data sources. Perform only the steps that are appropriate for
your data source.

Perform the following steps to configure the reports you published by using the
Publishing Wizard:

1.

10.

Start the Java Administration Launchpad. From the Microsoft Windows Start
menu, select Programs, then select Business Objects, then select Crystal Reports
Server, and then select Java Administration Launchpad. A browser opens and the
Welcome to the Administration Launchpad page is displayed.

Click Launch the Central Management Console. The Central Management
Console Log On page is displayed.

Enter the following in the fields on the Central Management Console Log On

page:

= Enter the host name of the system where Crystal Reports Server is running in
the System field.

= Enter your user name in the User Name field. The user name must be the
Administrator or a user with Administrator privileges.

= Enter your password in the Password field.

= Ensure the Authentication Type field is set to Enterprise and click Log On.
The Central Management Console page is displayed.

Click Folders. The Top Level Folders page is displayed.

Select the folder where the report was published. The contents of the folder is
displayed.

Click the report. The report details appear.

Enter the following information in the fields for the report details:

= Enter a title for the report in the Report Title field.

= Enter a description for the report in the Report Description field.

Click the Process tab. Click Database. The configured database information is
displayed.

Select the Use custom database logon information specified here option.

This step depends on whether you are using an Oracle or SQL Server data source.
Perform the steps appropriate to your data source as follows:

Oracle
a. Select the Select a database driver option and select Oracle from the list.

b. Enter the name of the connection string defined in the TNSNAMES.ora
configuration file in the Server field.




11.

12.

13.

14.

c. Enter your user name in the User Name field. The user name must be the
Administrator or a user with Administrator privileges.

d. Enter your password in the Password field.
e. Select the Specify a custom table prefix option.

Enter user_name. in the Specify a custom table prefix field, where
user_name represents the database user. For example:

oracledbluser.

Note: Ensure to include a period following the user name.

Microsoft SQL Server
a. Select the Specify a custom driver option and enter crdb_ado in the field.
b. Enter the host name of the SQL Server in the Server field.

c. Enter the name of the database in the Database field.

e

Enter your user name in the User Name field. The user name must be the
Administrator or a user with Administrator privileges.

e. Enter your password in the Password field.
f. Select the Specify a custom table prefix option.

Enter database_name.user_name. in the Specify a custom table prefix
field, where database_name represents the name of the database and
user_name represents the database user. For example:

sgldbl.sgldbluser.

Note: Ensure to include a period following the user name.

Select the Use same database logon as when report is run option and click
Update.

Click Parameters. The screen to set the default parameters for the report is
displayed.

Click any parameter to set a default value and to configure whether users should
be prompted for new values for the parameter when viewing.

Note: The Administrator should set the value for the Xellerate User
Login parameter by entering a valid Oracle Identity Manager user ID.
The Xellerate User Login parameter should not be set as a prompted
parameter. If an incorrect user ID is entered, then the user gets an
error message such as Error in database connector.

After setting the default values for any parameter, click Update.

Verify the appropriate servers are running by using the Central Configuration
Manager before running the report. From the Microsoft Windows Start menu,
select Programs, then select Business Objects, then select Crystal Reports Server,

10



and then select Central Configuration Manager. The Central Configuration
Manager is displayed.

15. Verify the appropriate servers are running by checking the Status column for each
server.

16. Click the Properties tab on the Central Management Console.

17. Click the Preview button to run the report and enter the appropriate information
when prompted. The report results appear in a Crystal Reports Viewer browser
window.

4 Creating Users, Configuring Access, and Distributing Reports

After configuring the published reports, you must create the users that will access the
reports and you must create the appropriate level of access permissions before
distributing the reports.

Perform the following steps:

1. Create users and the appropriate access permissions. See Crystal Reports
documentation for more information.

2. Distribute the Central Management Console's URL for the InfoView Web site to
the users.

The URL takes users to the login page where they can log in with the user ID and
password provided to them by the administrator. The users can then navigate to
the folder containing the report, select the appropriate input parameters for the
report by using the lookup lists, and run the report.

5 General Limitations

The following is a list of general limitations of using Crystal Reports Developer and
Crystal Reports Server to create Crystal Report versions of Oracle Identity Manager
reports:

= In order for users to be prompted for parameters, the user or administrator
responsible for publishing a report must enable the Prompt the user while
viewing property.

»  For reports with date type input parameters, users must provide a value or select
the Set to NULL option before they can run the report.

= You cannot replicate the Oracle Identity Manager User Defined Field reporting
feature in a Crystal Reports RPT file by adding it to the report input parameter list.

»  For reports with lookup based input parameters, users must either provide a value
or select the Set to NULL option before running the report.

s The date format of the date picker will always default to the following:
mm:dd:yyyy hh:mi:ss

The date format will not change according to the user language settings on the
client computer or browser settings.

= Exporting reports by using the Microsoft Word RTF Editable option causes the
column titles for the report to be displayed in page header.
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s Crystal Report versions of Oracle Identity Manager reports display encoded
values that are stored in the database, not values that appear in the Oracle Identity
Manager report. An example of this limitation is in columns based on lookups. For
the Employee Type column in the User Resource Access report, the Encoded
value, Full-Time, is displayed in the Crystal Report version of the report instead of
the decoded value, Full-Time Employee, that is displayed in the Oracle Identity
Manager version of the same report.

s The number of records per page cannot be configured. Crystal Reports attempts to
accommodate records based on the data and the space available on each page.

= Links, as used in Oracle Identity Manager reports, are not available in Crystal
Report versions of Oracle Identity Manager reports.

s The width of columns is determined when the report is designed. If the data
cannot fit into the width allocated for the column, the data wraps and prints on the
next line.

s The Oracle Identity Manager security model that dictates which values are visible
from a particular lookup is not enforced while selecting data from a lookup field.
Occasionally a report might return no data for a particular lookup value.

Note: If you are using Oracle as the data source, the SQL*Plus client
must be installed on the system where Crystal Reports Developer is
running. Crystal Reports uses the TNS connection to connect to the
Oracle database.

6 Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible to all users, including users that are disabled. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at http: //www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.

TTY Access to Oracle Support Services

To reach AT&T Customer Assistants, dial 711 or 1.800.855.2880. An AT&T Customer
Assistant will relay information between the customer and Oracle Support Services at
1.800.223.1711. Complete instructions for using the AT&T relay services are available at

12



http://www.consumer.att.com/relay/tty/standard2.html. After the
AT&T Customer Assistant contacts Oracle Support Services, an Oracle Support
Services engineer will handle technical issues and provide customer support according
to the Oracle service request process.
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